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Requirements 
WinTEC v4 requires a few things to run properly on your computer. 
 
Windows 98 or later, Windows XP is recommended 
1024x768 resolution or better 
Serial port 
 
Most laptops made in the last 5 years meet the resolution requirement.  If you do not meet this 
requirement, the software will still run, but will not fit on the screen.  Additionally, if you are using a 
large font to make your display easier to read; things may appear strange or misaligned.  It is strongly 
recommended that you use the normal font size with WinTEC. 
 
If you don’t have a serial port on your computer, PCMCIA (for older laptops) and ExpressCard (for 
newer laptops) adapters are available from a number of places online.  USB adapters are also widely 
available and tend to cost considerably less, but some work well and others do not work at all.  We have 
found that the Sabrent part# SBT-USC1M, works well. 
 

About 
WinTEC 4 is the latest release of Electromotive’s TEC tuning software.  This version was designed with 
the aim of making the tuning process as simple as possible by simplifying the user interface while 
keeping many of the best aspects of our earlier software to reduce the time required to be productive 
with the new software. 
 
With this in mind, we wrote WinTEC 4 to work with many different systems and firmware versions.  
Differences between units and firmware versions are all handled automatically.  As long as you have the 
newest version of WinTEC 4, you will always be able to communicate with any unit supported by 
WinTEC 4.  Because the feature set for each unit varies, unsupported features are hidden in the WinTEC 
software to prevent confusion. 
 
This manual covers only the use of the WinTEC 4 software.  For information on tuning your ECU, refer 
to the manual for your particular unit. 
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Using WinTEC v4 
WinTEC v4 is designed to be easy to navigate and use for most people without reading the manual.  But 
there are always useful pointers in the manual and if you have read this far, you are a rare breed and I 
commend your effort to educate yourself. 

Installing the software 
To install WinTEC, simply insert the CD into your 
CD ROM drive, open the drive in Windows Explorer 
and double click “Setup.exe”.  Desktop CDROM 
drives will have a ridge in the tray for the small CD.  
You will actually see two files called “setup”, look 
for the file with “.exe” on the end, .  The file you 
want is highlighted in Figure 1. 
 
Once setup begins follow the on screen instructions.  
You may change the installation directory if 

necessary, but the default directory is 
recommended. 

Configuring the software 
Selecting your Serial Port 
Chances are, before you will be able to communicate with your Electromotive system, you will need to 
change the communications port WinTEC is using.  You can change the port in the Control Panel by 
clicking on “Tools->Options->Control Panel” (Figure 2) and then clicking on the communications tab in 
the configuration screen (Figure 3). 

 

When you have a serial port on your computer, this is usually 1.  If you have a PCMCIA adapter, the 
port is often 3 or 4.  If you are using a USB adapter, the port number is different on almost every 
computer.  To find out what port number your COM port is, plug in your COM adapter if needed.  Right 
click on “My Computer”, click properties (Figure 4), select the Hardware tab and then click “Device 
Manager”.  You will see a tree that lists all the hardware in your computer.  Near the bottom there is a 

Figure 2: Bringing up the Control Panel 

Figure 1: The Setup file for installation 
 

Figure 3: Communications Tab 
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group called ‘Ports (COM & LPT)’ (Figure 5).  Double click on that item and you will see your port(s) 
listed along with the port number.  Note the number there (i.e. COM7) and close the device manager.  
Then go into WinTEC and select the port using the directions above. 
  
Changing the Dashboard appearance 
The appearance of the dashboard can be configured in the Control Panel by clicking on the Monitor tab 
(Figure 6).  The Day and Night mode radio buttons select the background for the dashboard.  Day mode 
(Figure 7) has a white background and defaults to black numbers and needles.  Night mode (Figure 8) 
has a black background and defaults to red needles and green numbers. 
 
Both day and night modes have 
default colors for the numbers and 
gauge needles, but both can be 
changed.  By clicking the Choose 
button next to the item you would 
like to change, you will be shown a 
color palette to select a color. 
 
By default, the cell in each table 
currently being used by the unit is 
highlighted in yellow.  Checking the 
option “Overlay AFR colors in 
Tables” makes the box highlight 
match the color of the AFR needle 
by default.  This option has no effect 
on the XDI2.  This option is 
described in more detail in the 
section on using the tables. 

Figure 4: Right-click ‘My Computer’ and then select 
Properties 

Figure 5: COM ports listed in 
Device Manager 

Figure 6: Monitor Options Screen 
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User Interface options 
When checked, the “Dock 2D Graphs in the lower portion of the screen” option forces the 2D graphs for 
tables such as the Warm-up enrichments over the dashboard (Figure 9).  While it covers the dashboard, 
it does prevent the window from covering any of the tuning options.  When unchecked, the graph is in a 
free floating window (Figure 10).  This is useful for large monitors because the graphs can be placed off 
to the side where they will not cover any tuning boxes. 

 
Selecting Datalog Graphs 
The datalog graph tab allows the selection of up to 10 channels to view in the flight recorder.  These 
settings are covered in the Flight Recorder section. 

Figure 7: Dashboard Day Mode 

Figure 8: Dashboard Night Mode (default) 

Figure 9: 2-D Graph Docked Figure 10: 2-D Graph Undocked 
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Fundamentals 
Save Often 
There are a few good habits to implement when doing anything on a computer.  These are especially 
good habits when tuning a car.  A computer crash in the middle of your work can be very frustrating.  
You’ve been working for two hours, finally feel like you’re getting somewhere, when the computer 
stops responding.  We’ve all had this happen at some time or another.  The best, and in fact the only way 
to prevent loss of your work before a crash occurs is to save often.  Really, you can’t save too often.  
Ctrl + S (the quick key to save your file) should be your best friend.  After you make a few changes, 
save the file by either clicking the save button or pressing Ctrl + S.  This minimizes the chances of 
losing work on the computer in any application. 
 
Choose a new name at milestones 
Another good habit to have is to save the file with a new name 
when you reach a milestone.  For example, you have gotten your 
car to the point where wide-open throttle is right, but you still have 
drivability issues to work out.  Before you begin making changes, 
save the file with a new name by clicking “File->Save As” and 
typing in a new name (Figure 11).  Clicking the Save button in the 
toolbar will also ask for a new file name.  This gives you the 
option of going back to a known point in the tune if you don’t like 
the result of the changes or something else goes wrong.  
Additionally this gives you multiple copies of your program in the 
event something happens to one of the copies. 
 
Know where your file is saved 
Another thing that can happen occasionally is you save your file, but don’t know or can’t remember 
where it is.  When you wish to retrieve your BIN file, the file should be stored where it may be easily 
found.  The best way to avoid this problem is to designate a specific place where you ALWAYS save 
your files.  WinTEC will always begin in WinTEC4\bins directory.  The WinTEC4 directory is in the 
‘Program Files’ directory on your hard drive (Local Disk C:).  This was done to avoid confusion and 
make your files easier to find when working with many files. 
 
Tips on Naming files 
The name of the file is very important.  It should tell you something about that file.  This is even more 
important when you deal with many BIN files or multiple applications in different vehicles because 
there may be a lot of information that must be conveyed.  The unit will store up to 24 characters, which 
should allow for plenty of description.  Don’t forget that the names must be helpful to you, but not 
necessarily to anyone else.  So if you deal with only your own car, “turbo initial tune” is probably 
enough.  If you change your cam, “turbo new cam” will work.  Adding the date is only useful if it will 
have meaning for you.  Someone who tunes many vehicles needs to be more careful.  The last name of 
the owner should probably be in the file name.  The date might be useful here so it can be matched up 
with a dyno sheet or a bill. 
 

Figure 11: File -> Save As 
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Backups 
Backups are very important.  If your computer breaks down or is stolen you need to have another copy 
of your BIN file somewhere separate so that you still have your data.  In the long run, the data is what 
makes the computer valuable.  Therefore, having a backup is essential. 
 
How often you need to backup is somewhat dependant on how often your data changes.  When working 
with a lot of files everyday, a backup every week is fine, but a backup every day would be better.  If you 
work with WinTEC only sporadically, backing up the data after you use it is a good idea.  Simply 
copying your data to CD or USB Flash drive is all that is needed.  Do not keep your backups in your 
laptop bag.  Keep them in a desk or a safe somewhere separate.  This way if your laptop and bag are 
stolen, you don’t lose your backups with it. 
 
What you use to backup your data is also important.  Floppy disks are inexpensive, widely available and 
often large enough to hold the data you need to backup, but tend to be very unreliable.  Any magnetic 
field near by can cause data corruption.  They also have a limited shelf life.  CD’s are much more 
reliable, and hold far more data allowing you to backup more data at once.  They also cannot be 
accidentally erased.  USB Flash drives are widely available, inexpensive, usually hold more than any 
CD could, can be reused and can be kept almost anywhere.  Shops may want to periodically backup up 
to CD for a more permanent backup, but pretty much everyone else will want to use a USB Flash drive. 
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Creating a New Calibration file 
Creating a new BIN file only requires filling out a form to get started.  To begin Click File -> Create a 
New BIN file.  This brings up the Create BIN wizard (Figure 15).  Follow this order for the best results: 
 
1. Select the unit type (TECGT, XDI2). 
2. Select the engine type 
3. Enter a maximum RPM.  This will 

be your default primary rev-limit. 
4. Select the MAP sensor type.  If 

you have an XDI2, skip to the end. 
5. Enter the maximum boost pressure 

you expect the selected units. 
6. Enter a Minimum Injector Turn-On 

time (MIT).  1.5 ms is a good 
starting point.  Some injector 
suppliers may include this 
information with the injectors. 

7. Enter a TPS fully closed voltage.  
You probably won’t know this if 
this is a new installation.  If you 
know the value, enter it here.  If 
not, leave it and change it in the 
sensor parameters when you have 
the monitor up and running. 

8. Select the camshaft style.  This 
effects the default setting for 
TPS/MAP Blend.  Street/Stock 
uses none, Race/High Perf has 
some entered by default.  

9. Enter the number of injectors. 
10. Select the injector current.  When 

running a single injector per channel, the 2-amp setting is the most common.  The 4-amp setting is 
generally used for two injectors per channel. 

11. Enter the estimated horsepower at the crank for your engine.  This may be just a guess, but the 
better your guess is, the closer to correct the TOG will be.  Don’t forget, that superchargers require 
engine power to turn; that power should be included in this guess. 

12. Check the alcohol fuel checkbox if you are running methanol or ethanol. 
13. When you click or tab over to the injector size box, the minimum size injector required will appear.  

Your actual injectors should be at least this size.  Enter the actual injector size in place of the 
minimum size, this size should account for any increase (or decrease) in fuel pressure. 

14. After entering the injector size and pressing enter, the suggested estimate for TOG will appear at the 
bottom of the window.  Enter this value in the TOG box. 

15. Leave IOT at 0 for now. 
 

Figure 15: Creating a BIN file 
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After completing the form, click “Create BIN file”.  This will complete the process and load the file.  
This file should be good enough to program into your unit and start the engine.  The tune will not be 
good, but, if your wiring is correct and you have no other problems the car should start and run well 
enough to get the car to a tuner or to begin tuning yourself. 

Opening an existing file 
If you already have a file you want to work with, click the Open button in 
the upper left of the screen (Figure 16), or press Ctrl + O.  If you have a 
file open already, you will be prompted to save the file before choosing 
the new file. 

Loading a Calibration into the unit 
Once you have the BIN file you are going to use, you must 
program your ECU before starting your engine for the first time.  
With the BIN file open and the unit connected to the PC and 
powered on, click the Program button at the top of the screen 
(Figure 17).  The unit will begin to program.  You will be 
instructed to cycle the power on the unit once the process is 
complete.  Pressing Ctrl + T will have the same effect as clicking 
the Program button. 
 
If a program operation fails, first make sure that your engine is not running.  Attempts to program a BIN 
file with the engine running will immediately fail.  If the engine is not running, check you connections 
and ensure that the unit is communicating with WinTEC. 

Editing a Calibration file 

Monitoring 
If the unit is turned off or otherwise loses connection while monitoring, a “Connecting…” message will 
appear in the lower right of the dashboard.  The “Connecting…” message will disappear and monitoring 
will begin or resume when the connection is re-established. 
 

 

Figure 17: Program Button 

Figure 16: Open a file 



WinTEC v4 Software User’s Guide 

Version 1.3 Page 10  Electromotive, Inc. 2010 

ONFLY tuning 
The ONFLY tuning feature allows changes to be made to the calibration while the engine is running so 
you can immediately see the effects.  Changes made ONFLY are temporary.   
With the exception of the GPIO options and the tables, all values that can be changed ONFLY will be 
highlighted with yellow.  If the boxes for the values are not yellow, and the unit is connected, 
monitoring must be enabled.  This will establish communication and enable ONFLY tuning. 
 
If you save the file with the unit connected, either by clicking “Save” or by pressing Ctrl + S, any 
ONFLY changes will be made permanent in the unit.  The engine may stumble very briefly when the 
changes are saved, this is normal and will not cause any damage.  If the unit is turned off without saving 
the changes to the PC, the unit will restart with your old settings.  You will need to program the unit to 
apply the new settings and make them permanent. 
 
Some settings cannot be changed ONFLY.  Here is the list of settings that must be changed and then 
saved and programmed to take effect: 
 
Engine type 
TDC tooth 
Injector peak current 
The function of any given GPIO channel 
Idle speed control valve type (2-wire, 4-wire) 
Any setting to enable/disable a subsystem or sensor (i.e. Idle Control On/Off, MAT Enable/Disable, etc) 
Turn IAC off at minimum duty 

Editing a Table 
Changing a single cell in the table is very simple.  Click on the cell you wish to edit or use the arrow 
keys to move to the cell you wish to change, type the new value and press enter.  The value may also be 
incremented up or down by using the “<” key for a decrement and the “>” key for an increment. 
 
Clicking and dragging over several cells or 
holding the shift key while moving the 
cursor with the arrow keys will select 
multiple cells (Figure 18).  Once the cells 
are selected, typing a new value will fill all 
of the cells with that value.  Multiple cells 
can be incremented or decremented with the 
“<” and “>” keys as well.  NOTE:  Non-
U.S. English keyboards may need to use the 
“,” and “.” Keys to do this operation if the 
“<” and “>” keys are not the shifted 

character of the “,” and “.” respectively.  
The cells may be incremented as many times 
as you like, but you will be warned if any of 
the values hit a limit (i.e. 60 degrees is maximum in the ignition table).  When changing multiple cells 
ONFLY, a red “Updating…” notice may appear in the lower right corner of the dashboard.  While that 

Figure 18: Selecting multiple cells in the table 
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notice is visible, the table may not be changed.  Once the update is complete, control will return to the 
table and you may continue to make changes. 
 
The row and column MAP and RPM points can be changed from any table (VE, Ignition, GPIO full 
table, etc).  Double clicking an RPM or MAP value will show a dialog box that asks for a new value.  
NOTE:  Any change you make to table break points affects all tables.  Clicking the Setup button brings 
up a screen allowing changes to all of the RPM and MAP values at once. 
 
When a unit is being monitored, a small red dot will float 
over the table in the location the unit is operating.  This 
simply shows you where the engine is operating to allow 
tuning to the appropriate part of the map.   
 
When attempting to tune a set of cells, it may be helpful 
to see all of the cells touched by the unit.  This can be 
done by enabling color persist.  In the software, this is 
called overlay.  This can be enabled and disabled by 
pressing Shift + O or clicking the down arrow next to 
Setup and selecting overlay ON or overlay OFF.  Color 
persist stops when changes are being made and must be 
re-enabled after the changes have been made for persist to 
continue.  Persist can be re-enabled either with the menu or by pressing Shift + O.  The colored cells will 
carry over to other tables when switching.  Clicking the options menu and selecting ‘Reset to White’ 
will clear the persist marks. 
 
There is an option in the options menu called AFR colors.  This makes the overlay change color with the 
AFR needle in the dashboard.  This option combined with persist makes it very easy to see where the 
mixture is lean or rich while tuning.  Normal Colors switches to the default yellow.  AFR colors can be 
set as the default in the Control Panel (See the section on Changing the Dashboard Appearance). 
 
You can view a 3-D graph of each table by clicking on the 
Tools menu (Figure 20) and selecting Graph.  One point on 
the graph is highlighted and the information for that point 
is displayed in the upper left of the graph window. 
 
Sometimes it is useful to see what the effective pulse width 
for each cell in the VE table will be.  To view pulse width, 
click on the tools menu and select Show Injector Pulse 
width Table or press Shift + P.  This option is only 
available in the VE table.  When viewing the pulse width 
table, any cells with a pulse less than the minimum turn on 
time will be highlighted in red.  Seeing the duty cycle in the 
VE table can also be quite useful.  Click the tools menu and 
select Show Injector DutyCycle or press Shift + D.  Any cell with greater than 100% duty cycle will be 
highlighted in red.  To return to the VE table, click the “Home” button (visible in Figure 19). 
 

Figure 19: Table Options Menu 

Figure 20: Table Tools Menu 
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Automatic VE 
The Automatic VE function allows for some automatic tuning of the VE table.  This function should 
only be used after power tuning has been done on the dyno.  Automatic VE may be used in two ways: 
from live monitor data as the vehicle is driven, or from a previously recorded data log.  To use 
Automatic VE, EGO correction must be enabled and the AFR Table filled in as desired.  These settings 
should then be programmed to the unit.  The EGO correction can be set to whatever you like, but values 
over 20% may cause erratic results without a lot of sample averages and a lot of data.   
 
To use Auto VE from live data, the ECU should be connected and active.  Go to the VE table and select 
“Automatic VE” from the Tools list.  To use Auto VE from a data log, the ECU should NOT be 
connected before selecting Automatic VE.  The data log must have EGO correction data.  Longer data 
logs (more than 15 minutes) that include many different driving conditions will provide the most 
correction with the least error. 
 
Once you have selected Automatic VE, you 
must enter the number of samples that will 
be averaged before modifying a cell.  A 
normal value would be 10 (the default).  
Fewer samples will result in faster 
adjustments to the table, but may result in 
less reliable results.  More samples will 
improve the result consistency but will 
require more data to make any adjustments. 
 
While Auto VE is running, no other changes 
may be made.  Cells that are modified by 
Auto VE will be highlighted.  Where fuel 
was removed cells will be light red.  Where 
fuel was added, cells will be light green.  When making adjustments from a data log, a progress bar will 
appear showing how much remains in the data log. 
 
Stop Auto VE by clicking the “Making Live Adjustments…” when using live data or “Cancel” while 
using a data log.  When the end of the data log is reached Auto VE will end automatically.  When Auto 
VE ends you will be asked if you wish to keep the changes made by Auto VE.  If you choose to keep the 
changes, be sure to save the BIN file and reprogram to 
the unit for the changes to take effect. 

Editing the General Purpose Input/Outputs 
(GPIOs) 
The GPIOs are very flexible and have a lot of options.  
To ease their configuration, the channels are shown 
numbered along with the corresponding pin number.  
Once selected, each channel will only show the 
functions available to that channel. 
 
To configure a GPIO, click on the General Purpose Figure 22: Selecting a GPIO channel 

(TECGT shown) 

Figure 21: Automatic VE control panel 
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Input/Output option in the Navigation tree.  In the configuration screen that appears, there is a drop 
down for selecting a GPIO channel (Figure 22). Some channels, will have an “input” or “output” next to 
the number.  This means that channel has only input or output functions available. 
 
After you select the channel you want, the list of available functions will be shown in the box below the 
channel drop down.  To select a function click the check box next to the function you want (Figure 23).  
The unit must be disconnected or powered off to change the function. 
 
Once you have selected a function, the configuration options will appear to the right.  Double click the 
option you want to change.  A dialog box asking for the new value and showing the acceptable range 
will appear (Figure 24). Enter the new value here.  Changes made here may be done ONFLY and will 
take immediate effect when the unit is connected and powered on. 
 

Configuring the EGO 
The TECGT supports both narrow band and wideband 
O2 sensors.  The correct type must be selected before it 
will operate correctly.  Click either Narrow Band or 
Wideband in the EGO Calibration screen to make the 
selection (Figure 25).  Narrow band is the default. 
 
Narrow band sensors virtually all work the same way.  
Therefore, the default calibration for the narrow band 
sensor should be fine.  Wideband sensors will each 
likely have a different calibration.  This information can 
typically be found in the documentation included with 
the sensor, or can be obtained from the manufacturer.  
The calibration data should be entered into the table in the middle of the screen (Figure 26).  The 
voltages must be in ascending order; so entering the values from highest to lowest may be necessary.  If 
the sensor calibration data is not properly entered, the AFR readings will most likely be incorrect. 
 

Figure 24: Changing a GPIO Parameter 
 

Figure 25: Select the EGO type 

Figure 23: Setting a GPIO Function 
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Figure 26: Calibration table for the EGO sensor 
 
The two numbers at the bottom are failure voltages (Figure 27).  If the EGO voltage is outside these two 
voltages for the amount of time defined in the EGO sensor parameters, a failure code will be triggered. 
 

 
Figure 27: EGO failure voltage settings 
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Flight Recorder 
The flight recorder in WinTEC v4 is meant to give the user a simple tool to record and view what the 
vehicle has done.  The flight recorder works like a VCR.  The data you have recorded on the dashboard 
can playback in real time or stepped through one frame at a time.  The data is also shown in graph form. 
 

 
Figure 28: The Flight recorder. 

Recording 
To start a new datalog, click the record button and enter a name for the session.  The name of the session 
defaults to Session_<date>_<time>, where <date> is today’s date and <time> is the current time on a 24 
hour clock to the second.  Names can be long and include spaces.  If your BIN file is open, “Session” is 
replaced with the BIN file name.  When you have recorded enough, click the stop button.  The datalog 
will then be loaded and ready for analysis.  
 
Only data log files made with WinTEC4.5 and later are supported. 

Playback 
If you did not just record a session, you will need to load a datalog before doing any play back.  Select a 
file by clicking on the Open button. 
 
The data will always play back on the dashboard in real time when playing a datalog, but the graphs help 
show trends and help to find anomalies.  If you have not already done so, you will need to select what 
data will be displayed in the small graphs on the right.  The graphs that will be displayed in the space at 
the right are selected in the Control Panel from the Datalog Graphs tab (Figure 29).  These options can 
also be reached by clicking the “Graphs” button at the upper right of the small datalog graphs.  You can 
select up to 10 channels for display.  The number or channels you have selected is the small blue number 
in the lower right of the select screen.  These graphs can be changed at any time, including during data 
log playback.  The selections you make will stick, so you won’t need to do this every time. 
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Control of the flight recorder works much like a 
VCR or DVD player.  Here is a brief description of 
what each control button does: 
 
First: Jump to the beginning of the file 
Rew: Step one record back (pauses playback if 
playing) 
Rev: Plays the file at the selected speed in reverse 
Stop: Halts playback.  Playback will resume from 
the current position.  If already stopped, timers and 
position is reset to the beginning. 
Play: Plays the file normally at the selected speed 
Fwd: Step one record forward (pauses playback if 
playing) 
Last: Jump to the end of the file 
Record: Begin recording a new file 
 
The playback speed can also be changed to quickly 
get to a specific point or to see a portion in more 
detail.  The playback speed slider above the control 
buttons changes the playback speed.  The Slowest 
setting is about ¼ speed and the fastest is about 4x 
normal speed. 
 
You can also jump immediately to any point in the datalog by clicking on a graph at the desired point in 
the datalog.  If the flight recorder is playing back when clicking on a graph, playback will be paused.  
Clicking play will continue playing from the new point. 
 

Figure 29: Data log Graph selection 
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Firmware Upgrade 
A firmware upgrade should not be taken lightly.  If your vehicle is operating properly and you are 
satisfied with the features you have, a firmware upgrade should not be performed.  If it is not broken, 
do not fix it. 
 
Doing a firmware upgrade is fairly simple but does require a number of steps.  Here are the steps to 
update the unit: 
 

1. If the unit you have does not have a firmware loader button (TEC3, TECS, TECM or TECGT 
starting with SN 301711), skip to step 7. 

2. Power the unit down and disconnect the serial cable from the unit 
3. Using a small Allen wrench or flat head screwdriver (no bigger than 3/32” or 2 mm), press the 

button behind the small hole next to the serial port. 
4. With this button held down, power on the unit.  This should not take much effort, do NOT press 

too hard.  You should feel the button give when pressed. 
5. The LEDs should indicate that the unit is in boot loader mode.  The TECGT should show red on 

top and green on the bottom.  XDI2 will show green on top and red on the bottom.  If the LEDs 
do not show what you expect, turn the unit off and repeat steps 4 and 5 until the sequence is 
correct. 

6. Once the unit is in boot loader mode, reconnect the serial cable. 
7.  Click on Tools -> Options -> Firmware upgrade. 
8. Click OK on the warning dialog that pops up. 
9. Specify the firmware upgrade file.  It will end in “.EM3”.  A file starting in “WTL” is for a 

TECGT and one beginning in “WXD” is for an XDI2.  “WTS” is for the TECS and “WTM” is for 
the TECM.  TEC3 firmware begins with “WT3”. 

10. Once selected, the process will begin.  Be sure not to disconnect the serial cable or turn the 
unit or the PC off during this process. 

11. When the process completes, turn the unit off, then back on.  This completes the process.  The 
BIN file already on the unit is kept intact. 

 
If for some reason the process fails, the unit will be in a standy mode waiting for the firmware to be 
flashed again.  Each unit handles this a little differently (see below).  Whether caused by the laptop 
losing power, the shop dog stepping on the serial cable or something else.  All is not lost.  Fix whatever 
may have caused the problem and start the process again from the step 1. 
 
Firmware load failure modes: 
XDI2, TECGT (before SN 301711): Top LED off, bottom LED red.  These units have a firmware loader 
button. 
TECS, TECGT (SN 301711 and later): Top LED amber, bottom LED green or red. 
TEC3: LED flashing green-red 
The TECM has no LEDs.   
 
All units with no firmware loader button will report the unit serial number to WinTEC when in the 
standby state but nothing else.  Simply perform the firmware upgrade again at this time. 
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Appendix: Shortcut keys 

Navigation 
F5 – Ignition table 
F6 – VE Table 
F7 – Staged Injection Table 
F8 – AFR Table 
Tab – jumps to the next box or from the tree to the first box of the selected screen 
Arrow Keys – Move around the navigation tree 

File Control 
Ctrl + N – Create a new file 
Ctrl + O – Open a file 
Ctrl + S – Save the current changes, make ONFLY changes permanent in the unit (if connected) 

TEC Control 
Ctrl + T – Program current BIN file into connected unit 

Table Control 
Shift + A – Toggle between Normal and Absolute VE values 
Shift + D – Toggle between Duty cycle and VE values 
Shift + P – Toggle between Pulse width and VE values 
Shift + O – Enable/Disable Overlay (color persist), Monitor mode only 
Shift + X – Close table and return to navigation tree 
Arrow Keys – move to another cell 
“<” or “,” – Decrement the selected cells by one (comma used on some non-US keyboards) 
“>” or “.” – Increment the selected cells by one (period used on some non-US keyboards) 
Shift + Arrow Key(s) – Select multiple cells 
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Glossary 
 
Advance: As applied to ignition timing, advancing the timing refers to firing the spark plug 
comparatively sooner. 
 
Boost: When a pressure that is greater than the ambient atmospheric pressure is forced into the intake 
manifold. Turbo- and superchargers create boost. 
 
Cam Sensor: A device used to provide a once-per-engine cycle pulse to the TEC. This establishes the 
stage of engine operation that is occurring for a given TDC. 
 
Closed Loop: When an oxygen sensor reading is used to correct the air-fuel mixture through the 
manipulation of the fuel injector pulse widths. 
 
Coolant Enrichment: A coolant temperature-based fuel enrichment that is used to add fuel when an 
engine is cold. This feature is the electrical equivalent of the choke plate on a carburetor. 
 
Coolant Temperature Sensor: A device that measures the coolant temperature of an engine. 
 
Crank Sensor: A device that can “read” a crank trigger wheel, and output a voltage signal that can be 
used by an engine management system. 
 
Crank Trigger: A device used to measure the crankshaft position and speed, typically composed of a 
crank trigger wheel and a crank sensor. 
 
Detonation: When the air-fuel mixture is ignited by the spark plug, then a high cylinder temperature 
“spontaneously” ignites another portion of the unburned mixture. A knocking sound is produced when 
detonation occurs, and knock sensors are designed to hear this knocking. Engine damage can be caused 
by detonation. 
 
DFU: Direct Fire Unit. Electromotive coil packs are referred to as DFUs. 
 
Directory: A subsection of disk space on a computer.  May be within another directory.  Typically used 
for organization.  Also called a Folder. 
 
Duty Cycle: The percentage of time that a pulse width modulated output is turned on. A duty cycle of 
100% indicates a fully turned-on modulation output. 
 
ECU: Electronic Control Unit. A device that is used to process several inputs for the control of several 
outputs. 
 
Exhaust Gas Oxygen (EGO) Sensor: A device that compares the oxygen content of the exhaust gases 
with the oxygen content of the ambient atmosphere. An air-fuel ratio approximation can be made with 
an EGO sensor. 
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Enrichment: A software parameter that adds injector pulse width (typically as a percentage) to the 
values defined by the raw fuel curve. 
 
Folder: See Directory. 
 
Fuel Pressure Regulator: A device that regulates the fuel rail (and thus the fuel injector) pressure. 
Generally equipped with a vacuum port referenced to manifold vacuum/boost to adjust fuel pressure on 
a 1-to-1 basis with manifold pressure. For example, a regulator will increase fuel pressure by 1 PSI for 
every PSI increase in manifold pressure. 
 
Gamma: This number defines that total modification to the raw fuel curve that is occurring at a given 
instant. A Gamma of 100% indicates that no modification is occurring to the raw fuel curve. A Gamma 
less than 100% indicates a leaner pulse width than the raw fuel curve value, while a Gamma greater than 
100% indicates a mixture that is richer than the raw fuel curve value. 
 
General Purpose Inputs (GPI): Input channels that the Electromotive systems can use to process data 
from sensors that are not related to the core engine management sensors. Switches and vehicle speed 
sensors can be run to the GPIs. 
 
General Purpose Input/Output (GPIO): Channel capable of the functions of either an Input or Output 
channel. 
 
General Purpose Outputs (GPO): Output channels from the Electromotive system that can be used to 
trigger external devices such as radiator fans, torque converters, etc. 
 
Horsepower (HP): A measurement of the rate at which an engine can perform work.  One HP = 550 lb-
ft per second.  This could also be measured in kilowatts (kW).  1 kW = 1.34 HP 
 
Idle Air Control (IAC) Motor: A device that is used to meter air into an engine at idle. 
Air from the outside of the intake manifold is regulated into the intake plenum by the 
IAC motor. 
 
Ignition Timing: The amount of degrees before Top Dead Center that a spark plug fires. 
 
IOT: Injector Offset Time. This number adds or subtracts a fixed pulse width from the raw fuel curve. 
The value of IOT is the amount of time (in milliseconds) that will be added or subtracted to the final 
pulse width. 
 
Knock Sensor: A device used to measure detonation. 
 
Knocking: see ‘Detonation’ 
 
Lean Mixture: An air-fuel mixture that carries less fuel than the stoichiometric air-fuel ratio. 
 
Manifold Air Pressure (MAP) Sensor: A device that measures the absolute pressure of the intake 
charge for an engine. 
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Manifold Air Temperature Enrichment: An inlet air temperature-based enrichment that is used to add 
fuel when the incoming air is cold, and therefore denser than usual. 
 
Manifold Air Temperature (MAT) Sensor: A device that measures the temperature of the incoming 
air charge for an engine. 
 
Millisecond (ms): A length of time equal to one one-thousandth of a second.  1 millisecond = 0.001 
second 
 
Mixture: A term used to describe the air and fuel entering the engine as a single entity. 
Open Loop: When an engine is running off of its base calibration with no EGO sensor feedback to 
correct the air-fuel ratio. 
 
Pinging: See ‘Detonation’. 
 
POT: Pulse-width Offset Time.  This is referred to as IOT in WinTEC4.  See ‘IOT.’   
 
Pre-Ignition: When the air-fuel mixture is ignited by a hot spot in the combustion chamber BEFORE 
the spark plug fires. When pre-ignition occurs, it produces a similar effect to over-advancing the ignition 
timing. Engine damage may result. 
 
Pulse width: The amount time that an injector is turned on for a given operating scenario. Expressed in 
milliseconds (ms). 
 
Pulse Width Modulation (PWM): When a variable pulsed voltage signal is supplied to a module, pulse 
width modulation is occurring. Fuel injectors are common examples of 
PWM-controlled modules. 
 
Stoichiometric Mixture: An air-fuel mixture that has the chemically ideal ratio between incoming air 
and fuel. When combusted, the product of a stoichiometric mixture will carry no excess oxygen or fuel. 
 
Retard: As applied to ignition timing, retarding the timing refers to firing the spark plug comparatively 
later. 
 
Rich Mixture: An air-fuel mixture that carries more fuel than the stoichiometric air-fuel ratio. 
 
Rising Rate Fuel Pressure Regulator: A Fuel Pressure Regulator that is adjustable to provide a non 1-
to-1 relationship between manifold pressure and fuel pressure. For example, a rising rate regulator may 
be used to supply 2psi of fuel pressure increase with every 1psi of manifold boost. 
 
Spark Knock: See ‘Detonation’ 
 
TFPW: Total Fuel Injector Pulse Width. This is referred to as Gamma in WinTEC4.  See ‘Gamma’. 
 
Throttle Position Sensor (TPS): A device used to measure the position or angle of the throttle plate. 
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TOG: Time for One Gamma. This number defines the slope of the raw fuel curve. When IOT is zero, 
the raw fuel curve will have zero pulse width at zero MAP sensor volts.  When the MAP sensor reads +5 
volts, the pulse width will be the number entered into TOG, expressed in milliseconds. 

 
Torque (TQ): A measurement of the force that an engine can generate at a given instant, typically 
expressed in pound-feet (lb*ft, U.S.) or Newton meters (Nm, metric). 
 
TPS/MAP Blend: A feature of the WinTEC software that allows the TPS and MAP sensor readings to 
be blended together. Typically, this feature is used on engines with radical cams or throttle-per-cylinder 
setups since these engines tend to have poor MAP signals at idle and part throttle. 
 
Trigger Wheel: A device attached to the crankshaft that provides a moving reference of speed and 
position of an engine’s crankshaft. 
 
UAP: User Adjustable Pulse Width (now TOG). This is referred to as TOG in WinTEC4.  See ‘TOG.’ 


